
Advanced Functions for Data Analysis
in Excel and Creating Advanced Chats 

in Excel

Application of Computers

PhD Bojan Prlinčević

AASKM

"Funded by the European Union. Views and opinions expressed are however those of the author(s) only and do not necessarily reflect those of the 

European Union. Neither the European Union nor the granting authority can be held responsible for them."



Introduction to Advanced Excel Functions

What are Advanced Functions?
Advanced Excel functions are powerful tools that enable complex data analysis, 
manipulation, and decision-making. They go beyond basic arithmetic to perform lookups, 
logical tests, statistical analysis, and data transformation—essential skills for engineering 
data analysis.
Why Advanced Functions Matter in Engineering:
• Automation: Reduce manual calculations and minimize errors
• Complex Analysis: Perform sophisticated data analysis quickly
• Data Management: Handle large datasets efficiently
• Decision Support: Create dynamic models and what-if scenarios
• Professional Reports: Generate automated, updateable analysis
• Time Efficiency: Complete in minutes what would take hours manually



Introduction to Advanced Excel Functions

Categories of Advanced Functions:
1. Logical Functions:
• Make decisions based on conditions
• Examples: IF, AND, OR, NOT, nested IF
• Use: Pass/fail criteria, conditional calculations, error handling
2. Lookup and Reference Functions:
• Find and retrieve data from tables
• Examples: VLOOKUP, HLOOKUP, INDEX, MATCH
• Use: Component specifications, data retrieval, cross-referencing
3. Statistical Functions:
• Analyze data distributions and trends
• Examples: AVERAGE, MEDIAN, STDEV, COUNT, MAX, MIN
• Use: Measurement analysis, quality control, data validation
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4. Text Functions:
• Manipulate and format text data
• Examples: CONCATENATE, LEFT, RIGHT, MID, TEXT
• Use: Data formatting, report generation, label creation
5. Date and Time Functions:
• Work with temporal data
• Examples: TODAY, NOW, DATE, DATEDIF
• Use: Project timelines, age calculations, scheduling
6. Mathematical Functions:
• Advanced calculations beyond basic operators
• Examples: ROUND, SUMIF, COUNTIF, ABS, POWER
• Use: Conditional summation, rounding, absolute values
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Engineering Applications:
• Component Selection: Use VLOOKUP to find resistor values from standard tables
• Quality Control: Use IF functions to flag measurements outside tolerance
• Statistical Analysis: Use AVERAGE, STDEV to analyze measurement precision
• Data Validation: Use logical functions to check data integrity
• Automated Reports: Combine functions to create dynamic analysis sheets
Course Objectives:
Master advanced Excel functions to perform sophisticated data analysis, automate 
calculations, create intelligent spreadsheets, and develop advanced visualizations for 
engineering applications.
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Learning Approach:
• Understand function syntax and arguments
• Practice with engineering-relevant examples
• Combine multiple functions for complex tasks
• Apply to real-world engineering scenarios
• Integrate with advanced charting techniques



Logical Functions - IF, AND, OR

IF Function:
Performs logical test and returns different values based on TRUE or FALSE result.
Syntax:
=IF(logical_test, value_if_true, value_if_false)  

Arguments:
• logical_test: Condition to evaluate (e.g., A1>5)
• value_if_true: Value returned if condition is TRUE
• value_if_false: Value returned if condition is FALSE
Example 1 - Pass/Fail Evaluation:
=IF(B2>=60, "PASS", "FAIL")  

• If score in B2 is 60 or higher, returns "PASS"
• Otherwise returns "FAIL"
Example 2 - Voltage Tolerance Check:
=IF(ABS(A2-5)<=0.1, "Within Tolerance", "Out of Tolerance")  

• Checks if voltage in A2 is within ±0.1V of 5V target
• Returns appropriate status message



Logical Functions - IF, AND, OR

Example 3 - Conditional Calculation:
=IF(C2>0, B2/C2, "N/A")  

• Calculates B2/C2 only if C2 is positive
• Avoids division by zero error
AND Function:
Returns TRUE only if ALL conditions are TRUE.
Syntax:
=AND(logical1, logical2, ...)  

Example - Multiple Criteria Check:
=AND(A2>=4.9, A2<=5.1, B2="Active")  

• Returns TRUE only if voltage is 4.9-5.1V AND status is "Active"
• All conditions must be met
OR Function:
Returns TRUE if ANY condition is TRUE.



Logical Functions - IF, AND, OR

Syntax:
=OR(logical1, logical2, ...)  

Example - Error Detection:
=OR(A2<0, A2>10, B2="Error")  

• Returns TRUE if voltage is negative, above 10V, OR status is "Error"
• Any single condition triggers TRUE
Combining IF with AND/OR:
Example 1 - Complex Pass/Fail:
=IF(AND(A2>=4.9, A2<=5.1, B2<100), "PASS", "FAIL")  

• PASS only if voltage is 4.9-5.1V AND current is below 100mA
• Both conditions required
Example 2 - Warning System:
=IF(OR(A2>5.5, B2>150), "WARNING", "Normal")  

• WARNING if voltage exceeds 5.5V OR current exceeds 150mA
• Either condition triggers warning



Logical Functions - IF, AND, OR

Example 3 - Multi-Level Grading:
=IF(A2>=90, "Excellent", IF(A2>=75, "Good", IF(A2>=60, "Pass", "Fail")))  

• Nested IF statements for multiple grade levels
• Evaluates from highest to lowest
Engineering Application - Component Testing:
Scenario: Test voltage regulator output
• Target: 5.0V ± 0.05V
• Maximum current: 200mA
• Temperature: Below 80°C
Formula:
=IF(AND(ABS(B2-5)<=0.05, C2<=200, D2<80), "PASS", "FAIL")  

Result: Component passes only if ALL three criteria are met



Logical Functions - IF, AND, OR

Best Practices:
• Use parentheses to clarify complex logic
• Test formulas with known values
• Consider all possible outcomes
• Use cell references instead of hardcoded values for flexibility
• Add comments to explain complex logic
Common Errors:
• Incorrect comparison operators (= vs ==)
• Missing parentheses in nested functions
• Circular logic
• Not handling edge cases (zero, negative, blank cells)



Nested IF and Advanced Logical Functions

Nested IF Functions:
Multiple IF functions inside each other for complex multi-condition logic.
Syntax:
=IF(test1, value1, IF(test2, value2, IF(test3, value3, default_value)))  
Example 1 - Grade Classification:
=IF(A2>=90, "A", IF(A2>=80, "B", IF(A2>=70, "C", IF(A2>=60, "D", "F"))))  
• Evaluates score against multiple thresholds
• Returns appropriate letter grade
• Maximum 64 nested levels in Excel (practical limit ~7)
Example 2 - Resistor Tolerance Classification:
=IF(B2<=1, "Precision", IF(B2<=5, "Standard", IF(B2<=10, "General", "Low Quality")))  
• Classifies resistors by tolerance percentage
• Multiple categories based on tolerance value
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Example 3 - Power Rating Selection:
=IF(A2<=0.125, "1/8W", IF(A2<=0.25, "1/4W", IF(A2<=0.5, "1/2W", IF(A2<=1, "1W", 
"2W+"))))  
• Selects appropriate resistor power rating based on calculated power
• Ensures adequate safety margin
Limitations of Nested IF:
• Difficult to read and maintain beyond 3-4 levels
• Easy to make errors in parentheses matching
• Hard to modify or expand
• Consider alternatives for complex logic
Alternative: IFS Function (Excel 2019+):
Cleaner syntax for multiple conditions.
Syntax:
=IFS(test1, value1, test2, value2, test3, value3, ...)
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Example - Grade Classification (IFS):
=IFS(A2>=90, "A", A2>=80, "B", A2>=70, "C", A2>=60, "D", A2<60, "F")  
• Cleaner than nested IF
• Evaluates conditions in order
• Returns value for first TRUE condition
NOT Function:
Reverses logical value (TRUE becomes FALSE, FALSE becomes TRUE).
Syntax:
=NOT(logical)  
Example 1 - Inverse Condition:
=IF(NOT(A2="Active"), "Check Status", "OK")  
• Triggers action when status is NOT "Active"
Example 2 - Combined with AND:
=IF(AND(A2>0, NOT(B2="Error")), "Valid", "Invalid")  
• Valid if A2 is positive AND B2 is NOT "Error"



Nested IF and Advanced Logical Functions

IFERROR Function:
Handles errors gracefully without displaying error messages.
Syntax:
=IFERROR(value, value_if_error)  
Example 1 - Division with Error Handling:
=IFERROR(A2/B2, 0)  
• Calculates A2/B2
• Returns 0 if division by zero or other error
• Prevents #DIV/0! error display
Example 2 - VLOOKUP with Error Handling:
=IFERROR(VLOOKUP(A2, Table1, 2, FALSE), "Not Found")  
• Looks up value in table
• Returns "Not Found" instead of #N/A error
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IFNA Function:
Specifically handles #N/A errors (common in lookup functions).
Syntax:
=IFNA(value, value_if_na)  
Example:
=IFNA(VLOOKUP(A2, Table1, 2, FALSE), "No Match")  
• Returns "No Match" only for #N/A errors
• Other errors still display normally
Engineering Application - Measurement Validation:
Scenario: Validate sensor readings with multiple criteria
• Range: 0-10V
• Precision: ±0.01V
• Status must be "Active"
• No error flags



Nested IF and Advanced Logical Functions

Formula:
=IF(AND(A2>=0, A2<=10, ABS(A2-B2)<=0.01, C2="Active", NOT(D2="Error")), "Valid", 
"Invalid")  
Complex Example - Component Selection Logic:
Requirements:
• Voltage rating > 1.5 × operating voltage
• Current rating > 1.2 × operating current
• Temperature rating > maximum ambient + 20°C
• Cost < budget
Formula:

=IF(AND(B2>A2*1.5, D2>C2*1.2, F2>E2+20, G2<H2), "Suitable",   
IF(OR(B2<=A2*1.5, D2<=C2*1.2), "Insufficient Rating",   

IF(F2<=E2+20, "Temperature Issue", "Over Budget")))  
Result: Provides specific reason for rejection if component doesn't meet criteria



Nested IF and Advanced Logical Functions

Best Practices:
• Limit nesting to 3-4 levels for readability
• Use IFS for multiple sequential conditions
• Always include IFERROR for formulas that might error
• Document complex logic with comments
• Test all possible paths through logic
• Consider using helper columns to break down complex formulas



VLOOKUP Function

VLOOKUP (Vertical Lookup):
Searches for value in first column of table and returns value from specified column in same 
row.
Syntax:
=VLOOKUP(lookup_value, table_array, col_index_num, [range_lookup])  

Arguments:
• lookup_value: Value to search for (e.g., component ID)
• table_array: Table range to search in (e.g., A2:D100)
• col_index_num: Column number to return value from (1 = first column)
• range_lookup: TRUE/FALSE or 1/0

• FALSE (0): Exact match (recommended for most cases)
• TRUE (1): Approximate match (requires sorted data)



VLOOKUP Function

How VLOOKUP Works:
1. Searches for lookup_value in first 

column of table_array

2. Finds matching row

3. Returns value from col_index_num

column in that row

4. Returns #N/A error if no match found

Formula to find resistance of R102:
=VLOOKUP("R102", A2:D6, 3, FALSE)  

• Searches for "R102" in column A
• Returns value from column 3 (Resistance)
• Result: 4700

Example 1 - Component Specification 
Lookup:
Table (A1:D6):



VLOOKUP Function

Example 2 - Dynamic Lookup with Cell Reference:
=VLOOKUP(F2, A2:D6, 3, FALSE)  
• Looks up part number entered in cell F2
• Returns corresponding resistance
• Formula updates automatically when F2 changes
Example 3 - Multiple Lookups:
Description: =VLOOKUP(F2, A2:D6, 2, FALSE)  
Resistance:  =VLOOKUP(F2, A2:D6, 3, FALSE)  
Tolerance:   =VLOOKUP(F2, A2:D6, 4, FALSE)  
• Retrieves multiple specifications for same part
• Each formula returns different column
Exact Match vs. Approximate Match:
Exact Match (FALSE):
• Finds exact match only
• Returns #N/A if no exact match
• Table does NOT need to be sorted



VLOOKUP Function
• Use for: Part numbers, IDs, names, discrete values
• Recommended for most engineering applications
Approximate Match (TRUE):
• Finds closest match less than or equal to lookup value
• Table MUST be sorted in ascending order (first column)
• Use for: Grade ranges, tax brackets, tiered pricing
• Returns largest value ≤ lookup_value

Formula:
=VLOOKUP(7, A2:B6, 2, TRUE)  
• Looks up 7A (not exact match in table)
• Finds largest value ≤ 7, which is 5A
• Returns corresponding wire gauge: 20 AWG

Example - Approximate Match 
(Wire Gauge Selection):
Table (sorted by current):



VLOOKUP Function
Common VLOOKUP Errors:
#N/A Error:
• Lookup value not found in first column
• Solution: Check spelling, data type (text vs. number), use IFERROR
#REF! Error:
• col_index_num exceeds number of columns in table_array
• Solution: Verify column index is within table range
#VALUE! Error:
• col_index_num is less than 1
• Solution: Use positive integer for column index
Wrong Result:
• range_lookup is TRUE but table not sorted
• Solution: Sort table or use FALSE for exact match



VLOOKUP Function
Engineering Application - Standard Component 
Selection:
Scenario: Select standard resistor value closest to 
calculated value

Formula (with error handling):
=IFERROR(VLOOKUP(A2, StandardValues, 2, TRUE), 
"Custom Value Required")  
• Finds closest standard value to calculated 
resistance in A2
• Returns component code
• Handles cases where no standard value is suitable

Standard Values 
Table (E12 series):



VLOOKUP Function

Best Practices:
• Always use FALSE for exact match unless specifically need approximate
• Use absolute references ($) for table_array when copying formulas
• Combine with IFERROR to handle missing values gracefully
• Ensure lookup column (first column) contains unique values
• Consider INDEX-MATCH as more flexible alternative



HLOOKUP, INDEX, and MATCH Functions

HLOOKUP (Horizontal Lookup):
Searches for value in first row of table and returns value from specified row.
Syntax:
=HLOOKUP(lookup_value, table_array, row_index_num, [range_lookup])  
Difference from VLOOKUP:
• Searches horizontally (across rows) instead of vertically (down columns)
• Lookup value must be in first ROW of table
• Returns value from specified ROW number
Example - Temperature Coefficient Lookup:
Table (A1:E3):
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Formula to find temperature coefficient of Aluminum:
=HLOOKUP("Aluminum", A1:E3, 3, FALSE)  
• Searches for "Aluminum" in row 1
• Returns value from row 3 (Temp Coeff)
• Result: 0.00429
When to Use HLOOKUP:
• Data organized horizontally (categories in rows)
• Time series data with dates in first row
• Less common than VLOOKUP in typical engineering applications
INDEX Function:
Returns value from specific cell in range based on row and column numbers.
Syntax:
=INDEX(array, row_num, [column_num])  
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Arguments:
• array: Range to retrieve value from
• row_num: Row number within array
• column_num: Column number within array (optional if single column)
Example 1 - Direct Cell Reference:
=INDEX(A2:D10, 3, 2)  
• Returns value from 3rd row, 2nd column of range A2:D10
• Equivalent to cell B4
Example 2 - Single Column:
=INDEX(C2:C10, 5)  
• Returns value from 5th row of column C
• Equivalent to cell C6
MATCH Function:
Returns position of value in range (not the value itself).
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Syntax:
=MATCH(lookup_value, lookup_array, [match_type])  
Arguments:
• lookup_value: Value to find
• lookup_array: Range to search in (single row or column)
• match_type:

• 0: Exact match (recommended)
• 1: Largest value ≤ lookup_value (requires sorted ascending)
• -1: Smallest value ≥ lookup_value (requires sorted descending)

Example - Find Position:
=MATCH("R102", A2:A10, 0)  
• Searches for "R102" in range A2:A10
• Returns position number (e.g., 3 if found in A4)
• Returns #N/A if not found
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INDEX-MATCH Combination:
Powerful alternative to VLOOKUP with more 
flexibility.
Syntax:
=INDEX(return_range, MATCH(lookup_value, 
lookup_range, 0))  
Advantages over VLOOKUP:
• Can look up values to the LEFT of lookup 
column
• No need to count columns (more robust 
when columns added/removed)
• Can search both rows and columns 
dynamically
• Faster performance with large datasets
• More flexible for complex lookups

Example 1 - Basic INDEX-MATCH:
Table:

Formula to find resistance of R102:
=INDEX(C2:C4, MATCH("R102", A2:A4, 0))  
• MATCH finds position of "R102" in 
A2:A4 (returns 2)
• INDEX returns value from 2nd position 
in C2:C4 (returns 4700)



HLOOKUP, INDEX, and MATCH Functions

Example 2 - Left Lookup 
(impossible with VLOOKUP):
=INDEX(A2:A4, MATCH(4700, 
C2:C4, 0))  
• Finds part number (column A) 
based on resistance value 
(column C)
• Looks LEFT from lookup column
• VLOOKUP cannot do this

Example 3 - Two-Way Lookup (Row and Column):
Table:

Formula to find Power in Week 2:
=INDEX(B2:D4, MATCH("Power", A2:A4, 0), 
MATCH("Week 2", B1:D1, 0))  
• First MATCH finds row (Power = row 3)
• Second MATCH finds column (Week 2 = column 2)
• INDEX returns intersection value: 0.51
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Engineering Application - Component Database Lookup:
Scenario: Large component database with specifications
Formula with error handling:
=IFERROR(INDEX(Specifications, MATCH(PartNumber, PartList, 0), MATCH(Parameter, 
HeaderRow, 0)), "Not Available")  
Benefits:
• Flexible: Works regardless of column order
• Robust: Adding columns doesn't break formula
• Bidirectional: Can look up in any direction
• Dynamic: Both part and parameter can be variables
Best Practices:
• Use INDEX-MATCH instead of VLOOKUP for complex lookups
• Always use match_type = 0 for exact match
• Combine with IFERROR for error handling
• Use named ranges for clarity (e.g., PartList, Specifications)
• Test with known values to verify correct operation
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Basic Statistical Functions:
AVERAGE Function:
Calculates arithmetic mean of values.
Syntax:
=AVERAGE(number1, [number2], ...)  
Example:
=AVERAGE(A2:A10)  
• Calculates average of values in A2:A10
• Ignores text and blank cells
• Use for: Central tendency, typical value
MEDIAN Function:
Returns middle value when data is sorted.
Syntax:
=MEDIAN(number1, [number2], ...)



Statistical Functions for Data Analysis

Example:
=MEDIAN(A2:A10)  

• Returns middle value (5th value if 9 data points)
• Less affected by outliers than AVERAGE
• Use for: Skewed distributions, outlier-prone data
MODE.SNGL Function:
Returns most frequently occurring value.
Syntax:
=MODE.SNGL(number1, [number2], ...)  

Example:
=MODE.SNGL(A2:A10)  

• Returns most common value
• Returns #N/A if no value repeats
• Use for: Discrete data, finding typical value
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Standard Deviation Functions:
STDEV.S (Sample Standard Deviation):
Calculates standard deviation for sample data.
Syntax:
=STDEV.S(number1, [number2], ...)  

Example:
=STDEV.S(A2:A10)  

• Measures spread/variability in data
• Uses n-1 denominator (sample)
• Use for: Experimental measurements (most common in engineering)
STDEV.P (Population Standard Deviation):
Calculates standard deviation for entire population.
Syntax:
=STDEV.P(number1, [number2], ...)  

• Uses n denominator (population)
• Use for: Complete datasets, known populations
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Variance Functions:
VAR.S and VAR.P:
Calculate variance (square of standard deviation).
Example:
=VAR.S(A2:A10)  

• Variance = (Standard Deviation)²
• Same sample vs. population distinction
Count Functions:
COUNT:
Counts cells containing numbers.
Syntax:
=COUNT(value1, [value2], ...)  

Example:
=COUNT(A2:A10)  

• Counts only numeric values
• Ignores text, blank cells, logical values
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COUNTA:
Counts non-empty cells.
Syntax:
=COUNTA(value1, [value2], ...)  

Example:
=COUNTA(A2:A10)  

• Counts cells with any content (numbers, text, errors)
• Use for: Counting entries regardless of type
COUNTBLANK:
Counts empty cells.
Syntax:
=COUNTBLANK(range)  

Example:
=COUNTBLANK(A2:A10)  

• Counts blank cells only
• Use for: Finding missing data
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COUNTIF:
Counts cells meeting specific criteria.
Syntax:
=COUNTIF(range, criteria)  

Examples:
=COUNTIF(A2:A10, ">5")          ' Counts values greater than 5  
=COUNTIF(A2:A10, "PASS")        ' Counts cells containing "PASS"  
=COUNTIF(A2:A10, ">=4.9")       ' Counts values ≥ 4.9  

COUNTIFS:
Counts cells meeting multiple criteria.
Syntax:
=COUNTIFS(criteria_range1, criteria1, [criteria_range2, criteria2], ...)  

Example:
=COUNTIFS(A2:A10, ">=4.9", A2:A10, "<=5.1", B2:B10, "PASS")  

• Counts rows where voltage is 4.9-5.1V AND status is "PASS"
• All criteria must be met
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MIN and MAX Functions:
MIN:
Returns smallest value.
Syntax:
=MIN(number1, [number2], ...)  

MAX:
Returns largest value.
Syntax:
=MAX(number1, [number2], ...)  

Examples:
=MIN(A2:A10)    ' Minimum voltage  
=MAX(A2:A10)    ' Maximum voltage  

SUMIF and SUMIFS:
SUMIF:
Sums values meeting criteria.
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Syntax:
=SUMIF(range, criteria, [sum_range])  

Example:
=SUMIF(B2:B10, "PASS", C2:C10)  

• Sums values in C2:C10 where corresponding B cell is "PASS"
SUMIFS:
Sums values meeting multiple criteria.
Syntax:
=SUMIFS(sum_range, criteria_range1, criteria1, [criteria_range2, criteria2], ...)  

Example:
=SUMIFS(D2:D10, B2:B10, ">=4.9", C2:C10, "<=100")  

• Sums power where voltage ≥4.9V AND current ≤100mA
AVERAGEIF and AVERAGEIFS:
Similar to SUMIF/SUMIFS but calculates average.
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Example:
=AVERAGEIF(B2:B10, ">5", A2:A10)  

• Average of A2:A10 where corresponding B value >5
Engineering Application - Measurement Analysis:
Scenario: Analyze 20 voltage measurements from power supply test
Data in A2:A21:
5.02, 5.01, 4.99, 5.03, 5.00, 4.98, 5.02, 5.01, 4.99, 5.00,
5.01, 5.02, 4.98, 5.03, 5.00, 4.99, 5.01, 5.02, 5.00, 4.98
Analysis Formulas:
Mean:              =AVERAGE(A2:A21)           ' Result: 5.005V
Median:            =MEDIAN(A2:A21)            ' Result: 5.005V
Std Deviation:     =STDEV.S(A2:A21)           ' Result: 0.016V
Minimum:           =MIN(A2:A21)               ' Result: 4.98V
Maximum:           =MAX(A2:A21)               ' Result: 5.03V
Range:             =MAX(A2:A21)-MIN(A2:A21)  ' Result: 0.05V
Count:             =COUNT(A2:A21)             ' Result: 20  
Within Tolerance:  =COUNTIFS(A2:A21,">=4.95",A2:A21,"<=5.05")  ' Result: 20  
Percent in Spec:   =COUNTIFS(A2:A21,">=4.95",A2:A21,"<=5.05")/COUNT(A2:A21)*100  ' Result: 100
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Interpretation:
• Mean = 5.005V (very close to 5.0V target)
• Std Dev = 0.016V (low variability, good precision)
• All measurements within ±1% tolerance
• Power supply meets specifications
Quality Control Application:
=IF(AND(AVERAGE(A2:A21)>=4.95, AVERAGE(A2:A21)<=5.05, STDEV.S(A2:A21)<=0.05), "PASS", "FAIL")  

• Automated pass/fail based on mean and standard deviation criteria



Advanced Conditional and Array Functions

SUMPRODUCT Function:
Multiplies corresponding elements 
in arrays and returns sum of 
products.
Syntax:
=SUMPRODUCT(array1, [array2], [array3], ...)  

Basic Example:
=SUMPRODUCT(A2:A5, B2:B5)  

• Calculates: (A2×B2) + (A3×B3) + 
(A4×B4) + (A5×B5)

Engineering Application - Total Power 
Calculation:
Data:

Formula:
=SUMPRODUCT(A2:A5, B2:B5)  
• Calculates total power: (5.0×0.5) + (3.3×1.2) + (12.0×0.3) + (5.0×0.8)
• Result: 2.5 + 3.96 + 3.6 + 4.0 = 14.06W



Advanced Conditional and Array Functions

Conditional SUMPRODUCT:
Use with logical conditions for advanced filtering.
Example - Conditional Sum:
=SUMPRODUCT((A2:A10>5)*(B2:B10))  

• Sums B values only where corresponding A value >5
• (A2:A10>5) creates array of TRUE/FALSE (1/0)
• Multiplying by B values includes only matching rows
Example - Multiple Conditions:
=SUMPRODUCT((A2:A10>=4.9)*(A2:A10<=5.1)*(B2:B10))  

• Sums B values where A is between 4.9 and 5.1
• Multiple conditions combined with multiplication (AND logic)
MAXIFS and MINIFS Functions:
Find maximum or minimum value meeting criteria.
MAXIFS Syntax:
=MAXIFS(max_range, criteria_range1, criteria1, [criteria_range2, criteria2], ...)
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Example:
=MAXIFS(C2:C10, A2:A10, ">=4.9", B2:B10, "PASS")  

• Returns maximum value from C2:C10 where A≥4.9 AND B="PASS"
MINIFS Syntax:
=MINIFS(min_range, criteria_range1, criteria1, ...)  

Example:
=MINIFS(C2:C10, A2:A10, ">=4.9", B2:B10, "PASS")  

• Returns minimum value from C2:C10 meeting criteria
LARGE and SMALL Functions:
Return nth largest or smallest value.
LARGE Syntax:
=LARGE(array, k)  

• k=1: Largest value (same as MAX)
• k=2: Second largest value
• k=3: Third largest value, etc.



Advanced Conditional and Array Functions

Example:
=LARGE(A2:A10, 2)  

• Returns second highest value in range
SMALL Syntax:
=SMALL(array, k)  

• k=1: Smallest value (same as MIN)
• k=2: Second smallest value
RANK Function:
Returns rank of number in list.
Syntax:
=RANK(number, ref, [order])  

Arguments:
• number: Value to rank
• ref: Array of values
• order: 0 = descending (1=highest), 1 = ascending (1=lowest)



Advanced Conditional and Array Functions

Example:
=RANK(A2, $A$2:$A$10, 0)  

• Returns rank of A2 value among all values in A2:A10
• 1 = highest value, 2 = second highest, etc.
• Use absolute reference ($) for ref when copying formula
PERCENTILE Function:
Returns value at specified percentile.
Syntax:
=PERCENTILE.INC(array, k)  

• k: Percentile value (0 to 1)
• 0.5 = 50th percentile (median)
• 0.95 = 95th percentile
Example:
=PERCENTILE.INC(A2:A100, 0.95)  

• Returns value below which 95% of data falls
• Use for: Specification limits, outlier detection



Advanced Conditional and Array Functions

QUARTILE Function:
Returns quartile value (25th, 50th, 75th percentile).
Syntax:
=QUARTILE.INC(array, quart)  

• quart: 0=min, 1=25th, 2=50th (median), 3=75th, 4=max
Example:
=QUARTILE.INC(A2:A100, 1)    ' First quartile (25th percentile)  
=QUARTILE.INC(A2:A100, 3)    ' Third quartile (75th percentile)  

Engineering Application - Statistical Process Control:
Scenario: Monitor production measurements, identify outliers
Data: 100 resistance measurements in A2:A101



Advanced Conditional and Array Functions

Analysis:
Mean:              =AVERAGE(A2:A101)  
Std Dev:           =STDEV.S(A2:A101)  
Upper Control:     =AVERAGE(A2:A101) + 3*STDEV.S(A2:A101)  
Lower Control:     =AVERAGE(A2:A101) - 3*STDEV.S(A2:A101)  
Out of Control:    =COUNTIFS(A2:A101,">"&(AVERAGE(A2:A101)+3*STDEV.S(A2:A101))) +   

COUNTIFS(A2:A101,"<"&(AVERAGE(A2:A101)-3*STDEV.S(A2:A101)))  
95th Percentile:   =PERCENTILE.INC(A2:A101, 0.95)  

Outlier Detection Formula (in column B):
=IF(OR(A2>AVERAGE($A$2:$A$101)+3*STDEV.S($A$2:$A$101),   

A2<AVERAGE($A$2:$A$101)-3*STDEV.S($A$2:$A$101)), "Outlier", "Normal")  

Best Practices:
• Use SUMPRODUCT for complex conditional calculations
• Combine statistical functions for comprehensive analysis
• Use absolute references ($) when copying formulas with fixed ranges
• Document criteria and thresholds clearly
• Validate results with known test data



Introduction to Advanced Charts

What are Advanced Charts?
Advanced charts go beyond basic column, line, and pie charts to provide sophisticated 
data visualization capabilities. They include combination charts, secondary axes, 
specialized chart types, and advanced formatting techniques essential for complex 
engineering data presentation.
Why Advanced Charts Matter:
Complex Data Relationships:
• Display multiple data types simultaneously (e.g., voltage and current)
• Show data with different scales on same chart
• Visualize correlations and patterns
• Compare actual vs. target values
Professional Communication:
• Publication-quality graphics for technical papers
• Executive dashboards with multiple metrics
• Comprehensive analysis in single visualization
• Enhanced clarity for complex datasets



Introduction to Advanced Charts

Engineering Applications:
• Dual-axis charts: Voltage and current on same time axis
• Combo charts: Actual values (columns) vs. targets (line)
• Scatter with trendlines: Correlation analysis, calibration curves
• Dynamic charts: Update automatically with new data
• Sparklines: Compact trend visualization in cells
Advanced Chart Types:
1. Combo Charts:
• Combine different chart types (e.g., column + line)
• Show related data with different visualization needs
• Example: Monthly sales (columns) with cumulative total (line)
2. Secondary Axis Charts:
• Two value axes with different scales
• Compare data with vastly different magnitudes
• Example: Voltage (0-10V) and power (0-100W) vs. time



Introduction to Advanced Charts

3. Advanced Scatter Charts:
• Multiple series with different markers
• Trendlines with equations and R² values
• Logarithmic scales for wide-range data
• Example: I-V characteristics of multiple diodes
4. Waterfall Charts:
• Show cumulative effect of sequential values
• Visualize how initial value is affected by positive/negative changes
• Example: Budget breakdown showing additions and subtractions
5. Box and Whisker Plots:
• Display statistical distribution (quartiles, median, outliers)
• Compare distributions across categories
• Example: Measurement variability across different test methods



Introduction to Advanced Charts

6. Histogram:
• Show frequency distribution of continuous data
• Identify data patterns and distributions
• Example: Distribution of resistor values in production batch
7. Pareto Charts:
• Combination of column and line chart
• Show individual values and cumulative percentage
• Example: Defect analysis (80/20 rule)
8. Sparklines:
• Miniature charts within cells
• Show trends without full chart
• Example: Quick visualization of weekly measurements



Introduction to Advanced Charts

Advanced Formatting Techniques:
Multiple Data Series:
• Different colors, markers, and line styles
• Custom formatting for each series
• Strategic use of emphasis
Error Bars:
• Display measurement uncertainty
• Standard deviation, standard error, or custom values
• Essential for scientific data presentation
Trendlines and Equations:
• Linear, polynomial, exponential, logarithmic
• Display equation and R² value
• Forecast future values



Introduction to Advanced Charts

Reference Lines:
• Horizontal/vertical lines for targets or limits
• Shaded regions for acceptable ranges
• Specification limits visualization
Dynamic Elements:
• Charts that update with data changes
• Named ranges for flexibility
• Interactive elements
Course Objectives:
• Master combination and dual-axis charts
• Create scatter plots with advanced analysis
• Apply appropriate chart types for complex data
• Format charts professionally for engineering documentation
• Implement dynamic and interactive visualizations



Introduction to Advanced Charts

Key Principle:
Choose chart complexity appropriate to your message. Advanced charts should clarify, 
not confuse. Use advanced features only when they add genuine value to data 
understanding.



Combination Charts and Secondary Axes

Combination (Combo) Charts:
Combine two or more chart types in single chart to display related data with different 
visualization needs.
Common Combinations:
• Column + Line
• Bar + Line
• Area + Line
• Stacked Column + Line
When to Use Combo Charts:
Different Data Types:
• Actual values (columns) vs. target or average (line)
• Individual measurements (columns) vs. cumulative total (line)
• Discrete categories (columns) vs. continuous trend (line)



Combination Charts and Secondary Axes

Emphasis:
• Highlight one data series differently
• Draw attention to comparison or relationship
• Show context for primary data
Creating Combo Chart:
Method 1 - Insert Combo Chart:
1. Select data range including all series
2. Insert tab → Charts group → Insert Combo Chart
3. Choose preset combo type: 

• Clustered Column - Line
• Clustered Column - Line on Secondary Axis

4. Chart appears with combination of types



Combination Charts and Secondary Axes

Method 2 - Change Existing Chart:
1. Create standard chart (e.g., column chart with multiple series)
2. Select chart
3. Chart Design tab → Change Chart Type
4. Choose Combo from chart type list
5. For each series, select chart type from dropdown
6. Check "Secondary Axis" box for series needing different scale
7. Click OK
Method 3 - Change Individual Series:
1. Select specific data series in chart (click on bars/line)
2. Right-click → Change Series Chart Type
3. Choose new chart type for that series
4. Repeat for other series as needed



Combination Charts and Secondary Axes

Example - Actual vs. Target:
Data:

Chart:
• Actual Output: Columns (blue)
• Target: Line with markers (red)
• Clearly shows performance relative to target
Secondary Axis:
Used when data series have vastly different scales or units.
When to Use Secondary Axis:
Different Scales:
• One series: 0-10 range
• Another series: 0-1000 range
• Without secondary axis, small values appear flat
Different Units:
• Voltage (V) and Power (W)
• Temperature (°C) and Pressure (kPa)
• Current (mA) and Resistance (kΩ)



Combination Charts and Secondary Axes

Example - Actual vs. Target:
Data:

Chart:
• Actual Output: Columns (blue)
• Target: Line with markers (red)
• Clearly shows performance relative to target
Secondary Axis:
Used when data series have vastly different scales or units.
When to Use Secondary Axis:
Different Scales:
• One series: 0-10 range
• Another series: 0-1000 range
• Without secondary axis, small values appear flat
Different Units:
• Voltage (V) and Power (W)
• Temperature (°C) and Pressure (kPa)
• Current (mA) and Resistance (kΩ)



Combination Charts and Secondary Axes

Creating Secondary Axis:
Method 1 - During Chart Creation:
1. Insert → Combo Chart → Clustered Column - Line on Secondary Axis
2. Excel automatically assigns line series to secondary axis
Method 2 - Add to Existing Chart:
1. Select data series to move to secondary axis
2. Right-click → Format Data Series
3. Series Options → Secondary Axis (radio button)
4. Secondary axis appears on right side
Method 3 - Change Chart Type:
1. Chart Design → Change Chart Type → Combo
2. Check "Secondary Axis" box for appropriate series



Combination Charts and Secondary Axes

Formatting Secondary Axis:
1. Click secondary axis (right side) to 

select
2. Right-click → Format Axis
3. Set bounds, units, number format 

independently
4. Add secondary axis title: Chart 

Design → Add Chart Element → 
Axis Titles → Secondary Vertical

Example - Voltage and Power vs. Time:
Data:

Chart Setup:
• Voltage: Line chart on primary axis (left, 0-5V scale)
• Power: Line chart on secondary axis (right, 0-25W scale)
• Both series visible and readable
• Different colors and markers for distinction



Combination Charts and Secondary Axes
Best Practices:
Visual Clarity:
• Use different chart types for primary and secondary series (e.g., column + line)
• Distinct colors for each axis (match axis color to series color)
• Clear axis titles with units
• Legend identifying each series
Axis Formatting:
• Set appropriate min/max bounds for each axis
• Align zero points if meaningful
• Use consistent intervals
• Consider logarithmic scale if needed
Avoid Confusion:
• Limit to 2-3 data series total
• Don't use secondary axis unless necessary
• Clearly label which series uses which axis
• Consider separate charts if relationship unclear



Combination Charts and Secondary Axes

Engineering Application - RC Circuit Analysis:
Scenario: Plot voltage and current during capacitor charging
Data:
• Time: 0-5 seconds
• Voltage: 0-5V (exponential rise)
• Current: 500-0 µA (exponential decay)
Chart:
• Primary axis (left): Voltage (V), 0-5V scale, blue line
• Secondary axis (right): Current (µA), 0-500µA scale, red line
• X-axis: Time (s)
• Shows inverse relationship between voltage and current
Formula Integration:
• Voltage calculated: =5*(1-EXP(-A2/1))
• Current calculated: =500*EXP(-A2/1)
• Chart updates automatically with time constant changes



Combination Charts and Secondary Axes

Common Mistakes to Avoid:
• Using secondary axis when not needed (creates confusion)
• Mismatched axis scales causing misleading visual comparisons
• Too many series (>3) making chart cluttered
• Unclear labeling of which series uses which axis
• Inconsistent formatting between primary and secondary elements



Advanced Scatter Charts and Trendline Analysis
Advanced Scatter Chart Techniques:
Multiple Data Series:
Display multiple relationships on same scatter chart for 
comparison.
Creating Multi-Series Scatter Chart:
1. Organize data with X-values in first column, 

multiple Y-series in subsequent columns
2. Select entire data range including headers
3. Insert → Scatter Chart
4. Each Y-column becomes separate series with 

unique color/marker

Example - Diode Comparison:
Data:

Chart:
• Three series (Diode A, B, C) with different markers
• Shows comparative I-V characteristics
• Legend identifies each diode



Advanced Scatter Charts and Trendline Analysis

Formatting Multiple Series:
1. Select individual series (click on data points)
2. Format Data Series pane
3. Customize for each series: 

• Marker: Different shapes (circle, square, diamond, triangle)
• Size: 6-10 points for visibility
• Fill: Distinct colors
• Line: Different styles (solid, dashed, dotted) or no line

Advanced Trendline Options:
Adding Multiple Trendlines:
• Each series can have its own trendline
• Different trendline types for different series
• Compare fit quality across series
Trendline Types Review:
1. Linear (y = mx + b):
• Straight line
• Best for: Constant rate of change
• Example: Ohm's law (V = IR)



Advanced Scatter Charts and Trendline Analysis

2. Exponential (y = ae^(bx)):
• Exponential growth or decay
• Best for: RC/RL circuits, radioactive decay
• Example: Capacitor charging/discharging
3. Logarithmic (y = a ln(x) + b):
• Logarithmic relationship
• Best for: Diminishing returns, saturation effects
• Example: Sensor response curves
4. Polynomial (y = ax^n + bx^(n-1) + ... + c):
• Curved line with peaks/valleys
• Order 2-6 (higher = more curves)
• Best for: Complex non-linear relationships
• Example: Temperature-dependent resistance
5. Power (y = ax^b):
• Power relationship
• Best for: Proportional relationships with exponent
• Example: Power dissipation (P = I²R)



Advanced Scatter Charts and Trendline Analysis

Displaying Equation and R²:
1. Select trendline
2. Right-click → Format Trendline
3. Check boxes: 

☑ Display Equation on chart
☑ Display R-squared value on chart

4. Equation and R² appear on chart
Understanding R² (Coefficient of Determination):
• Range: 0 to 1
• R² = 1.0: Perfect fit (all points on line)
• R² = 0.9-1.0: Excellent fit
• R² = 0.7-0.9: Good fit
• R² < 0.7: Poor fit (consider different trendline type)
• Measures how well trendline explains data variation



Advanced Scatter Charts and Trendline Analysis

Using Trendline Equation:
Example - Sensor Calibration:
Data: Sensor output vs. known input
Trendline: Linear
Equation: y = 0.0485x + 0.12
R²: 0.9987
Application:
• Use equation to convert sensor readings to actual values
• In Excel: =0.0485*A2+0.12
• High R² confirms linear relationship and accurate calibration
Forecasting with Trendlines:
Extend trendline beyond data range to predict future values.
Steps:
1. Select trendline
2. Format Trendline → Forecast
3. Enter periods: 

• Forward: Extend into future
• Backward: Extend into past

4. Trendline extends with dashed line



Advanced Scatter Charts and Trendline Analysis

Example:
• Historical data: 10 time points
• Forecast forward: 3 periods
• Trendline extends 3 points beyond last data point
• Use for: Trend projection, prediction
Logarithmic Axes:
Essential for data spanning multiple orders of magnitude.
When to Use:
• Frequency response (10 Hz to 1 MHz)
• Power measurements (µW to W)
• Resistance values (Ω to MΩ)
• Any data spanning 3+ decades
Creating Logarithmic Scale:
1. Select axis (click on axis numbers)
2. Right-click → Format Axis
3. Axis Options → Logarithmic scale (check box)
4. Base: Usually 10 (default)



Advanced Scatter Charts and Trendline Analysis

Example - Frequency Response (Bode Plot):
• X-axis: Frequency (Hz) - Logarithmic scale
• Y-axis: Gain (dB) - Linear scale
• Shows frequency response across wide range (10 Hz - 100 kHz)
Error Bars:
Display uncertainty or variability in data.
Adding Error Bars:
1. Select data series
2. Chart Elements (+) → Error Bars → More Options
3. Or Chart Design → Add Chart Element → Error Bars
Error Bar Types:
Fixed Value:
• Same error amount for all points
• Example: ±0.05V for all measurements
Percentage:
• Error proportional to value
• Example: ±5% of measured value



Advanced Scatter Charts and Trendline Analysis
Standard Deviation:
• Based on data variability
• Shows ±1 standard deviation
Standard Error:
• Standard deviation / √n
• Shows uncertainty in mean
Custom:
• Specify different error for each point
• Use range of cells containing error values
Engineering Application - Calibration Curve:
Scenario: Create calibration curve for temperature sensor
Data: 10 known temperatures with 3 measurements each
Chart: Scatter plot with average values
Error Bars: Standard deviation of 3 measurements
Trendline: Linear with equation and R²
Analysis:
• Equation: y = 0.0234x - 0.45, R² = 0.9995
• Error bars show measurement precision
• High R² confirms excellent linearity
• Use equation for temperature conversion



Advanced Scatter Charts and Trendline Analysis

Best Practices:
• Use appropriate trendline type for data relationship
• Always display R² to assess fit quality
• Try multiple trendline types, choose best R²
• Use logarithmic scales for wide-range data
• Include error bars for experimental data
• Format markers and lines for clarity
• Label axes with units
• Add descriptive title with key information



Specialized Chart Types

Histogram:
Shows frequency distribution of continuous data.
Purpose:
• Visualize data distribution
• Identify patterns (normal, skewed, bimodal)
• Detect outliers
• Assess process capability
Creating Histogram:
Method 1 - Built-in Histogram (Excel 2016+):
1. Select data range (single column of values)
2. Insert tab → Charts group → Insert Statistic Chart → Histogram
3. Excel automatically creates bins and counts frequency



Specialized Chart Types

Method 2 - Data Analysis ToolPak:
1. Data tab → Data Analysis → Histogram
2. Input Range: Select data
3. Bin Range: Optional (Excel creates automatic bins if blank)
4. Output options: New worksheet or range
5. Check "Chart Output"
Formatting Histogram:
• Adjust bin width: Right-click bars → Format Data Series → Bin Width
• Set number of bins: Format Data Series → Number of bins
• Remove gaps: Format Data Series → Gap Width → 0%
• Add axis labels and title
Example - Resistor Value Distribution:
Data: 100 measured resistor values (nominal 1kΩ)
Histogram: Shows distribution around 1000Ω



Specialized Chart Types
Analysis:
• Normal distribution centered at 1005Ω
• Standard deviation visible from spread
• Outliers visible as isolated bars
• Quality control assessment
Box and Whisker Plot:
Displays statistical distribution showing quartiles, median, and outliers.
Components:
• Box: Interquartile range (IQR) - 25th to 75th percentile
• Line in Box: Median (50th percentile)
• Whiskers: Extend to min/max within 1.5×IQR
• Points: Outliers beyond whiskers
Creating Box and Whisker Plot:
1. Select data range (can include multiple columns for comparison)
2. Insert tab → Insert Statistic Chart → Box and Whisker
3. Chart displays distribution for each data series



Specialized Chart Types

When to Use:
• Compare distributions across categories
• Identify outliers
• Assess data spread and symmetry
• Quality control across multiple batches
Example - Measurement Method Comparison:
Data: Three columns (Method A, B, C) with 20 measurements each
Chart: Three box plots side-by-side
Analysis:
• Compare median values (central line)
• Compare variability (box height)
• Identify outliers (individual points)
• Select most precise method
Waterfall Chart:
Shows cumulative effect of sequential positive and negative values.



Specialized Chart Types

Purpose:
• Visualize how initial value is affected by series of changes
• Show contribution of components to total
• Budget analysis, profit/loss breakdown
Creating Waterfall Chart:
1. Organize data with categories and values (positive/negative)
2. Select data range
3. Insert tab → Insert Waterfall or Stock Chart → Waterfall
4. Excel creates floating columns showing cumulative effect
Formatting:
• Set as Total: Right-click column → Set as Total (creates baseline column)
• Colors: Increase (green), Decrease (red), Total (blue)
• Connector lines: Show cumulative progression



Specialized Chart Types

Example - Project Budget Breakdown:
Data:

Chart: Shows how budget is consumed by each 
category, ending at remaining amount
Pareto Chart:
Combination chart showing individual values 
(columns) and cumulative percentage (line).
Purpose:
• Identify most significant factors (80/20 rule)
• Prioritize improvement efforts
• Quality control - defect analysis



Specialized Chart Types

Example - Defect Analysis:
Data (sorted by frequency):

Chart:
• Columns show defect counts
• Line shows cumulative percentage
• First two defects account for 73% of total (focus improvement 
here)
Sunburst Chart:
Hierarchical data visualization showing proportions at multiple 
levels.
Purpose:
• Display hierarchical relationships
• Show proportions within categories and subcategories
• Multi-level data breakdown

Creating Pareto Chart:
1.Organize data with categories and values (sorted descending by value)
2.Select data range
3.Insert tab → Insert Statistic Chart → Pareto
4.Excel creates column chart with cumulative percentage line



Specialized Chart Types
Creating Sunburst Chart:
1. Organize data hierarchically (parent-child relationships)
2. Select data range
3. Insert tab → Insert Hierarchy Chart → Sunburst
4. Inner ring = top level, outer rings = subcategories
Example - Project Cost Breakdown:
• Center: Total project
• Inner ring: Major categories (Hardware, Software, Labor)
• Outer ring: Subcategories (Processors, Memory, Storage under Hardware)
Treemap Chart:
Hierarchical data displayed as nested rectangles.
Purpose:
• Similar to sunburst but rectangular layout
• Show proportions and hierarchies
• Compare sizes visually



Specialized Chart Types
Creating Treemap:
1. Organize hierarchical data
2. Insert tab → Insert Hierarchy Chart → Treemap
3. Rectangle size proportional to value
Funnel Chart:
Shows progressive reduction through stages.
Purpose:
• Visualize process with sequential stages
• Show conversion rates
• Identify bottlenecks
Example - Manufacturing Yield:
• Stage 1: 1000 units started
• Stage 2: 950 passed inspection
• Stage 3: 920 passed testing
• Stage 4: 900 shipped
• Chart shows narrowing funnel with yield at each stage



Specialized Chart Types

Engineering Applications:
Quality Control:
• Histogram: Distribution of measurements
• Box plot: Compare batches or methods
• Pareto: Identify main defect types
Process Analysis:
• Waterfall: Cost or time breakdown
• Funnel: Yield through production stages
Data Distribution:
• Histogram: Assess normality
• Box plot: Identify outliers



Specialized Chart Types

Best Practices:
• Choose chart type matching data structure and message
• Use histogram for continuous data distribution
• Use box plot for comparing distributions
• Use Pareto for prioritization (80/20 analysis)
• Format clearly with labels and titles
• Consider audience familiarity with chart type



Sparklines - Compact Data Visualization

What are Sparklines?
Sparklines are miniature charts embedded directly in cells, providing compact visual 
representation of data trends without creating full-size charts.
Characteristics:
• Fit within single cell
• No axes, labels, or legends
• Show trend or pattern at a glance
• Update automatically with data changes
• Ideal for dashboards and data tables
Types of Sparklines:
1. Line Sparkline:
• Miniature line chart
• Shows trend over time or sequence
• Best for: Continuous data, time series



Sparklines - Compact Data Visualization
2. Column Sparkline:
• Miniature column chart
• Shows individual values as bars
• Best for: Comparing values, identifying peaks
3. Win/Loss Sparkline:
• Shows positive/negative/zero as bars
• Positive: Up bar, Negative: Down bar, Zero: Gap
• Best for: Binary outcomes, pass/fail, profit/loss
Creating Sparklines:
Steps:
1. Select cell where sparkline will appear
2. Insert tab → Sparklines group → Choose type (Line, Column, or Win/Loss)
3. Create Sparklines dialog opens
4. Data Range: Select cells containing data to visualize
5. Location Range: Confirm cell for sparkline (pre-filled)
6. Click OK
7. Sparkline appears in cell



Sparklines - Compact Data Visualization
Example - Weekly Measurements:
Data (A2:G2):

Sparkline in H2:
• Insert → Line Sparkline
• Data Range: A2:G2
• Shows weekly trend in single cell
Copying Sparklines:
• Create sparkline in first row
• Copy cell (Ctrl+C)
• Select range for additional sparklines
• Paste (Ctrl+V)
• Each row gets sparkline for its data

Formatting Sparklines:
Sparkline Tools Design Tab:
Appears when sparkline cell is selected.
Style Options:
• Sparkline Style: Predefined color schemes
• Sparkline Color: Custom line/column color
• Marker Color: Highlight specific points
Markers (Line Sparklines):
• High Point: Highest value (green)
• Low Point: Lowest value (red)
• First Point: First value (blue)
• Last Point: Last value (orange)
• Negative Points: Negative values (red)
• Markers: All data points



Sparklines - Compact Data Visualization

Show Group:
Check boxes to display markers:
☑ High Point
☑ Low Point
☑ First Point
☑ Last Point
☑ Negative Points
☑Markers
Axis Options:
• Vertical Axis Min/Max:

o Automatic (each sparkline scaled independently)
o Same for All (consistent scale across sparklines)
o Custom Value

• Horizontal Axis:
o General (evenly spaced points)
o Date Axis (use actual dates for spacing)

• Show Axis: Display horizontal axis line (useful for positive/negative data)



Sparklines - Compact Data Visualization

Example - Temperature Monitoring:
Data Table:

Sparklines in "Trend" column:
• Line sparklines showing daily 
temperature
• High/Low points marked
• Quick visual comparison across sensors
• Sensor B shows higher temperatures and 
more variation

Win/Loss Sparkline Example:
Data - Daily Test Results:

Data Preparation:
• Convert Pass/Fail to 1/-1
• Pass = 1, Fail = -1
• Create Win/Loss sparkline from numeric data



Sparklines - Compact Data Visualization

Engineering Applications:
Dashboard Integration:
• Add sparklines to data tables for instant trend 
visualization
• Monitor multiple parameters simultaneously
• Identify anomalies quickly
Example - Power Supply Testing:
Table:

Analysis:
• PS01: Flat sparkline = stable output
• PS02: Rising sparkline = voltage 
drift (investigate)
• PS03: Jagged sparkline = noise 
(investigate)



Sparklines - Compact Data Visualization

Quality Control Application:
Production Monitoring:

• Batch B sparkline shows declining trend → investigate process



Sparklines - Compact Data Visualization

Best Practices:
Effective Use:
• Use in tables alongside data for context
• Consistent formatting across related sparklines
• Appropriate type for data (line for trends, column for comparisons, win/loss for 
binary)
• Mark high/low points for line sparklines
Scaling:
• Use "Same for All" axis scaling when comparing across rows
• Use "Automatic" when each row represents independent measurement
• Consider custom min/max for consistent reference
Color Coding:
• Use color to convey meaning (green=good, red=bad)
• Highlight high/low points with contrasting colors
• Maintain consistency across dashboard



Sparklines - Compact Data Visualization

Limitations:
• No axes or labels (context must come from surrounding data)
• Limited interactivity
• Not suitable for precise value reading
• Best for trends and patterns, not exact values
Advantages:
• Space-efficient
• Quick visual scanning
• Integrates with data tables
• Automatic updates
• Easy to create and format



Dynamic Charts with Named Ranges

What are Dynamic Charts?
Charts that automatically update when data is added, removed, or modified, without 
manual adjustment of data ranges.
Benefits:
• Automatic updates with new data
• No manual range adjustment needed
• Reduced errors
• Time savings
• Professional, maintainable solutions
Methods for Creating Dynamic Charts:
Method 1 - Excel Tables:
Simplest method for dynamic charts.



Dynamic Charts with Named Ranges

Steps:
1. Select data range
2. Insert tab → Table (or Ctrl+T)
3. Check "My table has headers"
4. Click OK
5. Data converts to formatted table
6. Create chart from table data
7. Chart automatically expands/contracts with table
Advantages:
• Automatic range expansion
• Structured references (e.g., Table1[Voltage])
• Built-in filtering and sorting
• Professional formatting



Dynamic Charts with Named Ranges

Example:
• Table with voltage measurements
• Add new row → Chart automatically includes new data
• Delete row → Chart automatically updates
Method 2 - Named Ranges with OFFSET:
More flexible, works with non-table data.
OFFSET Function:
Returns reference to range offset from starting cell.
Syntax:
=OFFSET(reference, rows, cols, [height], [width])  
Dynamic Range Formula:
=OFFSET(Sheet1!$A$2, 0, 0, COUNTA(Sheet1!$A:$A)-1, 1)  



Dynamic Charts with Named Ranges

Explanation:
• Starts at A2 (first data cell)
• Offset 0 rows, 0 columns (stays at A2)
• Height: COUNTA(A:A)-1 (counts non-empty cells minus header)
• Width: 1 column
• Range automatically adjusts as data added/removed
Creating Named Range:
1. Formulas tab → Define Name
2. Name: "DynamicData"
3. Refers to: Enter OFFSET formula
4. Click OK



Dynamic Charts with Named Ranges

Using in Chart:
1. Create chart
2. Select chart → Chart Design → Select Data
3. Edit series
4. Series values: =Sheet1!DynamicData
5. Click OK
Example - Dynamic Voltage Data:
Named Range "VoltageData":
=OFFSET(Data!$B$2, 0, 0, COUNTA(Data!$B:$B)-1, 1)  
Named Range "TimeData":
=OFFSET(Data!$A$2, 0, 0, COUNTA(Data!$A:$A)-1, 1)  
Chart Series:
• X-values: =Data!TimeData
• Y-values: =Data!VoltageData
• Add new measurement → Chart updates automatically



Dynamic Charts with Named Ranges
Method 3 - Dynamic Range with INDEX:
Alternative to OFFSET using INDEX function.
Formula:
=Data!$A$2:INDEX(Data!$A:$A, COUNTA(Data!$A:$A))  
Explanation:
• Starts at A2
• Ends at last non-empty cell in column A
• INDEX finds last row with data
Interactive Charts with Form Controls:
Adding Drop-Down List:
1. Developer tab → Insert → Form Controls → Combo Box
2. Draw combo box on worksheet
3. Right-click → Format Control
4. Input range: List of options
5. Cell link: Cell to store selection number
6. Click OK



Dynamic Charts with Named Ranges

Using Selection in Chart:
• Use INDEX or CHOOSE function to select data series based on dropdown
• Chart displays selected data dynamically
Example - Component Selection:
Dropdown: Lists component IDs (R101, R102, R103)
Cell Link: Cell A1 (stores selection: 1, 2, or 3)
Chart Data:
=INDEX(ComponentData, A1, 2)  
• Displays specifications for selected component
• Change dropdown → Chart updates



Dynamic Charts with Named Ranges

Scroll Bar for Time Range:
1. Developer tab → Insert → Scroll Bar
2. Format Control: 

• Min value: 1
• Max value: 100 (total data points)
• Cell link: Cell storing current position

3. Use cell value to define visible range in chart
Example - Scrolling Time Window:
• Display last 20 measurements
• Scroll bar moves window through dataset
• Chart shows selected 20-point window
Formula for Dynamic Window:
=OFFSET(Data!$A$2, ScrollValue, 0, 20, 1)  
• Starts at row determined by scroll bar
• Shows 20 rows
• Scroll bar changes starting point



Dynamic Charts with Named Ranges

Engineering Application - Real-Time Monitoring:
Scenario: Temperature monitoring with continuous data logging
Setup:
• Data table with timestamps and temperatures
• Named range automatically includes all data
• Chart displays data dynamically
• New measurements added → Chart updates automatically
• Optional: Scroll bar to view historical data
Implementation:
1. Convert data to Excel Table
2. Create line chart from table
3. Add scroll bar for time window selection
4. Add dropdown for sensor selection (if multiple sensors)
5. Chart updates automatically with new data and user selections



Dynamic Charts with Named Ranges

Best Practices:
Choosing Method:
• Excel Tables: Best for most cases, simplest implementation
• Named Ranges: When tables not suitable or more control needed
• Form Controls: For interactive dashboards and user selection
Performance:
• OFFSET is volatile (recalculates frequently) - can slow large workbooks
• INDEX method is non-volatile (better performance)
• Consider performance with large datasets
Maintenance:
• Document named range formulas
• Use descriptive names (e.g., "VoltageData" not "Range1")
• Test with data additions/deletions
• Verify chart updates correctly



Dynamic Charts with Named Ranges

Error Handling:
• Ensure formulas handle empty cells
• Test with minimum data (1-2 rows)
• Verify behavior when data deleted



Chart Best Practices for Advanced Visualizations

Design Principles for Complex Charts:
Clarity Over Complexity:
• Advanced features should enhance understanding, not obscure it
• Every element should serve a purpose
• Remove unnecessary decoration
• Focus on data, not chart effects
Appropriate Complexity:
• Match chart complexity to audience expertise
• Technical audience: Can handle more complex visualizations
• Executive audience: Prefer simpler, clearer charts
• Consider presentation context (paper, presentation, dashboard)



Chart Best Practices for Advanced Visualizations
Consistency:
• Maintain consistent formatting across related charts
• Use same color scheme throughout document
• Consistent axis scales for comparable charts
• Standard fonts and sizes
Professional Formatting:
Color Strategy:
Meaningful Colors:
• Use color to convey information, not just decoration
• Consistent color coding (e.g., blue=measured, red=target)
• Limit palette to 3-5 colors for clarity
• Consider colorblind-friendly palettes
Contrast:
• Sufficient contrast between elements
• Dark colors on light background or vice versa
• Avoid low-contrast combinations (yellow on white, light gray on white)



Chart Best Practices for Advanced Visualizations
Emphasis:
• Use color to highlight important data
• Muted colors for context, bright colors for focus
• Example: Gray for historical data, blue for current period
Typography:
Font Selection:
• Professional fonts: Arial, Calibri, Helvetica
• Avoid decorative fonts
• Consistent font family throughout chart
Font Sizes:
• Title: 14-16 pt
• Axis titles: 11-12 pt
• Axis labels: 10-11 pt
• Legend: 10-11 pt
• Data labels: 9-10 pt
• Readable when printed or projected



Chart Best Practices for Advanced Visualizations
Text Orientation:
• Horizontal text preferred for readability
• Rotate axis labels only if necessary
• Avoid vertical text when possible
Axis Formatting:
Scale Selection:
• Start Y-axis at zero for bar/column charts (avoid misleading scaling)
• Non-zero start acceptable for line charts if clearly indicated
• Use logarithmic scale for wide-range data (multiple decades)
• Consistent scales across comparable charts
Gridlines:
• Subtle gridlines (light gray, thin lines)
• Major gridlines only (avoid minor unless necessary)
• Horizontal gridlines most useful for reading values
• Vertical gridlines optional, use sparingly



Chart Best Practices for Advanced Visualizations

Tick Marks:
• Appropriate intervals for easy reading
• Round numbers preferred (0, 5, 10 vs. 0, 4.7, 9.4)
• Not too many (cluttered) or too few (hard to read)
Labels and Titles:
Chart Title:
• Descriptive and specific
• Include key information (conditions, parameters)
• Example: "Capacitor Voltage vs. Time (R=10kΩ, C=100µF, T=25°C)"
• Not: "Chart 1" or "Voltage"
Axis Titles:
• Always include units in parentheses or brackets
• Example: "Voltage (V)", "Time (s)", "Frequency (Hz)"
• Clear description of what axis represents



Chart Best Practices for Advanced Visualizations
Legend:
• Clear series identification
• Positioned to not obscure data
• Consider removing if only one series (use chart title instead)
• Order matches visual order in chart when possible
Data Labels:
• Use sparingly (can clutter chart)
• Include when specific values important
• Format consistently (decimal places, units)
• Position to avoid overlap
Engineering-Specific Guidelines:
Technical Accuracy:
• Accurate representation of data (no distortion)
• Appropriate significant figures
• Error bars for experimental data
• Document data source and conditions



Chart Best Practices for Advanced Visualizations
Standards Compliance:
• Follow IEEE, ISO, or institutional guidelines
• Standard symbols and notation
• Proper figure numbering and captions
• Reference charts in text
Documentation:
• Include measurement conditions
• Note any data processing (filtering, averaging)
• Specify equipment and methods
• Date of data collection
Reproducibility:
• Sufficient information to reproduce chart
• Clear methodology
• Raw data available if needed



Chart Best Practices for Advanced Visualizations
Common Mistakes to Avoid:
Visual Errors:
• 3D effects (distort perception, avoid unless necessary)
• Excessive decoration (chart junk)
• Poor color choices (low contrast, too many colors)
• Inconsistent formatting across charts
Data Errors:
• Misleading scales (truncated Y-axis on bar chart)
• Inappropriate chart type for data
• Missing error bars on experimental data
• Unlabeled or poorly labeled axes
Technical Errors:
• Missing units
• Incorrect axis assignment
• Inappropriate trendline type
• No indication of sample size or uncertainty



Chart Best Practices for Advanced Visualizations

Chart Review Checklist:
Before finalizing chart, verify:
☑ Appropriate chart type for data and message
☑ Clear, descriptive title with key information
☑ Axis titles with units
☑ Readable font sizes
☑ Appropriate axis scales
☑ Legend (if multiple series)
☑ Consistent formatting with other charts
☑ No unnecessary decoration



Chart Best Practices for Advanced Visualizations

Chart Review Checklist:

☑ Readable in black-and-white
☑ Error bars (if experimental data)
☑ Trendline with equation/R² (if applicable)
☑ Professional color scheme
☑ All text horizontal and readable
☑ No overlapping labels
☑ Sufficient contrast



Practical Engineering Examples - Advanced Analysis

Example 1 - Multi-Variable Circuit Analysis
Objective: Analyze RC circuit behavior with varying time constants
Data:

Chart Type: Line chart with multiple series
Key Elements:
• Three series with different colors and markers
• X-axis: Time (s), linear scale
• Y-axis: Voltage (V), 0-5V
• Legend identifying each time constant
• Horizontal reference line at 63.2% (one time 
constant marker)
• Title: "RC Circuit Charging - Effect of Time 
Constant"



Practical Engineering Examples - Advanced Analysis

Analysis:
• Smaller τ: Faster charging (reaches 5V sooner)
• Larger τ: Slower charging (more gradual curve)
• All curves follow exponential pattern
• At t=τ, voltage reaches ~63.2% of final value (3.16V)
Advanced Feature:
• Add exponential trendlines to each series
• Display equations showing V = 5(1-e^(-t/τ))
• Verify theoretical vs. measured values



Practical Engineering Examples - Advanced Analysis

Example 2 - Sensor Calibration with Error Analysis
Objective: Create calibration curve for pressure sensor 
with uncertainty
Data (3 measurements per point):

Chart Type: Scatter chart with error 
bars and trendline
Setup:
• X-axis: Pressure (kPa)
• Y-axis: Sensor Output (V)
• Data points: Average values with 
markers
• Error bars: ±1 standard deviation
• Linear trendline with equation and R²
Formulas:
Average:  =AVERAGE(B2:D2)  
Std Dev:  =STDEV.S(B2:D2)



Practical Engineering Examples - Advanced Analysis

Trendline:
• Type: Linear
• Equation: y = 0.0499x + 0.0067
• R²: 0.9999
Analysis:
• Excellent linearity (R² = 0.9999)
• Slope: 0.0499 V/kPa (sensitivity)
• Intercept: 0.0067V (offset)
• Small error bars indicate good precision
• Calibration equation: Pressure = (Output - 0.0067) / 0.0499
Application:
=IF(A2="", "", (A2-0.0067)/0.0499)  
• Converts sensor output to pressure reading
• Use in measurement spreadsheet



Practical Engineering Examples - Advanced Analysis

Example 3 - Frequency Response 
Analysis (Bode Plot)
Objective: Plot amplifier frequency 
response with dual Y-axes
Data:

Chart Type: Combo chart with secondary axis and 
logarithmic X-axis
Setup:
• X-axis: Frequency (Hz), logarithmic scale
• Primary Y-axis (left): Gain (dB), linear scale
• Secondary Y-axis (right): Phase (°), linear scale
• Gain: Line chart (blue) on primary axis
• Phase: Line chart (red) on secondary axis
Key Elements:
• Logarithmic X-axis (frequency spans 6 decades)
• Two Y-axes with different scales
• Different colors for gain and phase
• Markers at measurement points
• Horizontal reference line at -3dB (cutoff frequency)
• Title: "Amplifier Frequency Response (Av=100, 
BW=10kHz)"



Practical Engineering Examples - Advanced Analysis

Analysis:
• Flat gain (~40dB) in passband (10Hz - 10kHz)
• -3dB point at ~10kHz (cutoff frequency)
• Rolloff at high frequencies
• Phase shift increases with frequency
• -45° phase at cutoff frequency (typical for first-order system)
Advanced Features:
• Add vertical line at cutoff frequency
• Calculate bandwidth from -3dB points
• Display specifications in text box on chart



Practical Engineering Examples - Advanced Analysis

Example 4 - Statistical Process Control Dashboard
Objective: Monitor production quality with multiple visualizations
Data: 100 resistance measurements from production line
Dashboard Components:
1. Control Chart (Line Chart):
• X-axis: Sample number (1-100)
• Y-axis: Resistance (Ω)
• Data points with line
• Horizontal lines:

o Center line (mean): 1000Ω
o Upper control limit (UCL): Mean + 3σ
o Lower control limit (LCL): Mean - 3σ

• Points outside control limits highlighted in red



Practical Engineering Examples - Advanced Analysis

2. Histogram:
• Shows distribution of measurements
• Normal distribution curve overlay
• Specification limits marked
3. Summary Statistics (Table):
Mean:              =AVERAGE(Data)           1000.5Ω  
Std Deviation:     =STDEV.S(Data)           8.2Ω  
Min:               =MIN(Data)               978Ω  
Max:               =MAX(Data)               1023Ω  
Range:             =MAX(Data)-MIN(Data)     45Ω  
Within Spec:       =COUNTIFS(Data,">=990",Data,"<=1010")  95  
Percent in Spec:   =Within/COUNT(Data)*100  95%  
Cp:                =(1010-990)/(6*STDEV.S(Data))  0.41  

4. Sparklines:
• One sparkline per production batch (20 batches, 5 samples each)
• Quick visual identification of batch trends



Practical Engineering Examples - Advanced Analysis

Analysis:
• Process centered at target (1000Ω)
• 95% within specification (990-1010Ω)
• Cp = 0.41 (process capability insufficient, needs improvement)
• No points outside control limits (process in control)
• Distribution approximately normal
Action Items:
• Reduce process variation (improve Cp to >1.33)
• Investigate batches with declining sparkline trends
• Continue monitoring for out-of-control points



Practical Engineering Examples - Advanced Analysis

Example 5 - Comparative Performance 
Analysis
Objective: Compare three voltage 
regulators across multiple parameters
Data:

Visualizations:
1. Radar Chart:
• Shows all parameters for all regulators on single 
chart
• Each regulator = different colored line
• Quickly identifies strengths/weaknesses
• Normalized scales for comparison
2. Comparison Table with Conditional Formatting:
• Green: Meets or exceeds target
• Yellow: Close to target
• Red: Fails to meet target
• Sparklines showing trend if historical data available
3. Scatter Plot - Cost vs. Efficiency:
• X-axis: Cost ($)
• Y-axis: Efficiency (%)
• Each regulator = data point
• Identifies best value (high efficiency, low cost)



Practical Engineering Examples - Advanced Analysis

Analysis:
• Reg A: Good balance, meets most specs, moderate cost
• Reg B: Best performance, highest efficiency, but most expensive
• Reg C: Lowest cost, but poor regulation and efficiency
• Recommendation: Reg A for cost-sensitive applications, Reg B for performance-
critical applications
Decision Matrix:
Score = (Efficiency/100) × 0.3 + (1-LoadReg/10) × 0.3 + (1-LineReg/10) × 0.2 + (1-Cost/5) × 0.2  

• Weighted scoring based on priorities
• Reg B: 0.85 (highest score)
• Reg A: 0.78
• Reg C: 0.62



Practical Engineering Examples - Advanced Analysis

Key Takeaways:
Function Mastery:
• Combine logical, lookup, and statistical functions for powerful analysis
• Use IFERROR for robust formulas
• INDEX-MATCH more flexible than VLOOKUP
• Statistical functions essential for measurement analysis
Chart Selection:
• Match chart type to data structure and message
• Use combo charts and secondary axes for multi-variable data
• Scatter charts with trendlines for correlation analysis
• Specialized charts (histogram, box plot) for statistical analysis



Practical Engineering Examples - Advanced Analysis

Professional Presentation:
• Clear titles and labels with units
• Appropriate scales and formatting
• Consistent style across related charts
• Error bars for experimental data
• Accessibility considerations
Dynamic Solutions:
• Excel tables for automatic chart updates
• Named ranges for flexibility
• Form controls for interactivity
• Sparklines for compact visualization



Practical Engineering Examples - Advanced Analysis

Engineering Applications:
• Calibration curves with error analysis
• Frequency response (Bode plots)
• Statistical process control
• Multi-parameter comparison
• Automated data analysis and reporting



Creating Your First Chart
Example - Creating Voltage vs. Time Chart:
Data:
Steps:
1. Select A1:B6 (including headers)
2. Insert → Recommended Charts
3. Select Line chart
4. Click OK
5. Chart shows voltage increasing over time



Working with Chart Tools

Chart Tools Contextual Tabs:
When chart is selected, two contextual tabs appear in ribbon:
1. Chart Design Tab:
Controls overall chart structure, data, and appearance.
Key Groups:
• Chart Layouts: Quick access to predefined element combinations
• Chart Styles: Color schemes and visual styles
• Data: Edit data source, switch row/column, select data
• Type: Change chart type
• Location: Move chart to new sheet or embed in worksheet



Working with Chart Tools

2. Format Tab:
Controls detailed formatting of individual chart elements.
Key Groups:
• Current Selection: Choose specific element to format
• Insert Shapes: Add shapes to chart
• Shape Styles: Quick formatting for shapes
• WordArt Styles: Text formatting options
• Arrange: Layer order, alignment, grouping
• Size: Precise chart dimensions
Selecting Chart Elements:
Method 1 - Click Element:
• Click directly on element (title, axis, legend, etc.)
• Handles appear around selected element
• Format tab → Current Selection shows element name



Working with Chart Tools

Method 2 - Chart Elements Dropdown:
• Format tab → Current Selection group → Chart Elements dropdown
• Select element from list
• Useful for small or overlapping elements
Method 3 - Keyboard:
• Select chart
• Press Up/Down arrow keys to cycle through elements
Chart Buttons (Right Side of Chart):
Three buttons appear when chart is selected:
1. Chart Elements (+):
• Add, remove, or position chart elements
• Checkboxes for quick element visibility
• Submenu arrow for element options
• Elements: Axes, Axis Titles, Chart Title, Data Labels, Data Table, Error Bars, 
Gridlines, Legend, Trendline



Working with Chart Tools

2. Chart Styles (paintbrush):
• Apply predefined color schemes and styles
• Style tab: Complete chart styles
• Color tab: Color schemes only
3. Chart Filters (funnel):
• Show/hide specific data series or categories
• Temporarily filter chart data without changing source
• Useful for focusing on specific data
Moving and Resizing Charts:
• Move: Click chart area, drag to new location
• Resize: Click chart, drag corner handles (maintain aspect ratio) or side handles
• Precise Size: Format tab → Size group → enter exact dimensions
• Move to New Sheet: Chart Design tab → Location group → Move Chart



Adding and Formatting Chart Elements
Adding Chart Title:
Select chart
Click Chart Elements button (+) → Check Chart Title
Or Chart Design tab → Add Chart Element → Chart Title → position
Click title text box and type descriptive title
Example: "Capacitor Voltage vs. Time During Charging"
Formatting Chart Title:
• Select title → Home tab → Font formatting (bold, size, color)
• Or right-click title → Format Chart Title → detailed options
• Font, fill, border, shadow, 3D effects
Adding Axis Titles:
Chart Elements (+) → Check Axis Titles
Or Chart Design → Add Chart Element → Axis Titles
Choose Primary Horizontal and/or Primary Vertical
Click axis title and type label with units
Example: "Time (s)" for horizontal, "Voltage (V)" for vertical



Adding and Formatting Chart Elements

Formatting Axes:
Select axis (click on numbers/labels)
Right-click → Format Axis
Format Axis pane opens with options: 

Axis Options: Bounds (min/max), units, scale, position
Tick Marks: Major/minor tick mark style
Labels: Position, number format
Number: Decimal places, format (general, number, scientific)

Key Axis Settings:
• Minimum/Maximum Bounds: Control axis range (auto or manual)
• Major Unit: Interval between gridlines and labels
• Minor Unit: Subdivisions (if minor gridlines shown)
• Logarithmic Scale: For wide data ranges (decades)
• Values in Reverse Order: Flip axis direction



Adding and Formatting Chart Elements

Adding Legend:
Chart Elements (+) → Check Legend
Choose position: Right, Top, Bottom, Left
Legend shows series names with color/marker
Formatting Legend:
• Select legend → drag to reposition
• Right-click → Format Legend → fill, border, font
• Delete individual legend entry: Select entry → Delete (hides series)
Adding Data Labels:
Chart Elements (+) → Check Data Labels
Or Chart Design → Add Chart Element → Data Labels → position
Positions: Center, Inside End, Outside End, Data Callout
Shows values directly on data points



Adding and Formatting Chart Elements

Formatting Data Labels:
• Right-click data label → Format Data Labels
• Label Options: Value, Series Name, Category Name, Percentage
• Number format, font, fill, border
Adding Gridlines:
Chart Elements (+) → Gridlines → choose options
Primary Major Horizontal (most common)
Primary Major Vertical (optional)
Minor gridlines for finer divisions
Formatting Gridlines:
• Right-click gridline → Format Gridlines
• Line style, color, width, dash type
• Subtle gridlines (light gray) recommended for professional appearance



Chart Styles and Colors

Applying Chart Styles:
Chart styles are predefined combinations of colors, effects, and formatting that give charts 
professional appearance instantly.
Method 1 - Chart Styles Button:
Select chart
Click Chart Styles button (paintbrush icon)
Style tab shows style thumbnails
Hover to preview
Click to apply
Method 2 - Chart Design Tab:
Select chart
Chart Design tab → Chart Styles group
Click More button to see full gallery
Choose style



Chart Styles and Colors

Style Categories:
• Styles 1-8: Colorful with various effects
• Styles 9-16: Monochromatic with shading
• Each style includes specific color scheme, fonts, and effects
Changing Chart Colors:
Modify color scheme without changing overall style.
Steps:
Select chart
Chart Styles button → Color tab
Or Chart Design tab → Chart Styles group → Change Colors
Choose from color schemes: 

Colorful: Multi-color palettes
Monochromatic: Single color variations
Theme Colors: Match document theme



Chart Styles and Colors

Manual Color Customization:
Select specific data series (click bar, line, or slice)
Right-click → Format Data Series
Fill & Line options
Choose solid fill, gradient, pattern, or picture
Select custom color
Formatting Individual Data Points:
Click data series once (selects entire series)
Click specific data point again (selects only that point)
Right-click → Format Data Point
Apply unique color or formatting
Use to highlight specific values or outliers



Chart Styles and Colors

Color Best Practices:
Professional Appearance:
• Use consistent color scheme throughout document
• Limit to 3-5 colors for clarity
• Ensure sufficient contrast for readability
• Consider colorblind-friendly palettes
Engineering Documentation:
• Match institutional or publication style guidelines
• Use standard colors for specific meanings (red=error, green=pass)
• Ensure charts are readable in black-and-white printing
• Test print preview before finalizing



Chart Styles and Colors

Accessibility:
• High contrast between data series
• Avoid red-green combinations (colorblind consideration)
• Use patterns or markers in addition to colors
• Include legend for color identification
Theme Colors:
• Chart colors automatically match document theme
• Change document theme: Page Layout tab → Themes
• All charts update to match new theme colors



Creating Column and Bar Charts

Column Charts:
Vertical bars comparing values across categories.
When to Use:
• Comparing discrete categories
• Showing changes over time (limited time points)
• Multiple data series comparison
• Emphasizing individual values
Column Chart Subtypes:
1. Clustered Column:
• Multiple series displayed side-by-side
• Easy comparison within and across categories
• Best for: Comparing 2-4 series across categories
• Example: Comparing voltage output of three power supplies under different loads



Creating Column and Bar Charts

2. Stacked Column:
• Series stacked on top of each other
• Shows contribution to total
• Best for: Part-to-whole relationships over categories
• Example: Total power consumption with breakdown by component
3. 100% Stacked Column:
• Stacked columns normalized to 100%
• Shows relative proportions
• Best for: Comparing percentage distribution across categories
• Example: Percentage of total current through each branch
Creating Column Chart:
Organize data with categories in first column, values in subsequent columns
Select data range including headers
Insert → Column Chart → Choose subtype
Chart appears with categories on X-axis, values on Y-axis



Creating Column and Bar Charts

Example Data - Component Testing:
Result:
Clustered column chart with
three groups (supplies) and 
three series (tests)



Creating Column and Bar Charts

Bar Charts:
Horizontal bars comparing values across categories.
When to Use:
• Long category names (easier to read horizontally)
• Ranking or ordering data
• Many categories (more vertical space)
• Emphasizing comparison rather than time
Bar Chart Subtypes:
Same as column charts but horizontal orientation:
• Clustered Bar
• Stacked Bar
• 100% Stacked Bar



Creating Column and Bar Charts

Creating Bar Chart:
Select data range
Insert → Bar Chart → Choose subtype
Categories appear on Y-axis (vertical), values on X-axis (horizontal)
Formatting Column/Bar Charts:
Gap Width:
• Select data series → Format Data Series
• Series Options → Gap Width slider
• Smaller gap: Wider bars, more emphasis on values
• Larger gap: Narrower bars, more white space



Creating Column and Bar Charts

Overlap:
• For clustered charts only
• Negative overlap: Bars separated
• Zero overlap: Bars touching
• Positive overlap: Bars overlapping
Engineering Application - Resistor Tolerance:
Chart comparing measured vs. nominal resistance values with tolerance bands visualized 
through error bars or reference lines.



Creating Line Charts

Line Charts:
Show trends and changes over continuous variables, typically time.
When to Use:
• Time series data (measurements over time)
• Continuous data (not discrete categories)
• Showing trends and patterns
• Multiple data series comparison
• Large number of data points
Line Chart Subtypes:
1. Line:
• Lines only, no markers
• Clean appearance for many data points
• Best for: Smooth trends, multiple series
2. Line with Markers:



Creating Line Charts

2. Line with Markers:
• Lines with markers at each data point
• Emphasizes individual measurements
• Best for: Fewer data points, highlighting specific values
3. Stacked Line:
• Lines stacked showing cumulative values
• Less common, can be confusing
• Best for: Cumulative totals over time
4. 100% Stacked Line:
• Shows percentage contribution over time
• Best for: Relative proportions changing over time



Creating Line Charts

Creating Line Chart:
Organize data with X-values 
(time/independent variable) in first 
column
Y-values (measurements/dependent 
variable) in subsequent columns
Select data range including headers
Insert → Line Chart → Choose subtype
Chart shows X-values on horizontal axis, 
Y-values on vertical axis
Example Data - RC Circuit Charging:
Result: Line chart showing exponential 
charging curve



Creating Line Charts

Formatting Line Charts:
Line Style:
• Select data series → Format Data Series
• Line options: Solid, gradient, no line
• Width: Thickness (0.75 pt to 6 pt)
• Dash type: Solid, dashed, dotted
• Use different line styles to distinguish series
Markers:
• Format Data Series → Marker Options
• Built-in markers: Circle, square, diamond, triangle, etc.
• Size: Adjust marker size (3-20 points)
• Fill and border: Customize marker appearance
• Use different markers for each series



Creating Line Charts

Smooth Lines:
• Format Data Series → Line → Check "Smoothed line"
• Creates curved lines between points
• Use for: Theoretical curves, trend visualization
• Avoid for: Actual measured data (can misrepresent)
Multiple Series:
• Each series gets unique color and marker
• Legend identifies each series
• Format each series individually for clarity
Engineering Applications:
Waveforms:
• Voltage or current vs. time
• Input and output signals on same chart
• Periodic signals (sine waves, square waves)



Creating Line Charts

Frequency Response:
• Gain vs. frequency
• Phase vs. frequency
• Use logarithmic scale for frequency axis
Temperature Monitoring:
• Temperature vs. time during experiment
• Multiple sensors on same chart
Calibration Curves:
• Sensor output vs. known input
• Linear or polynomial trendline



Creating Pie Charts

Pie Charts:
Show proportional relationships—how parts contribute to a whole.
When to Use:
• Single data series only
• Showing percentage or proportional distribution
• Limited categories (5-7 maximum for clarity)
• Emphasizing one or two segments
• Total equals meaningful whole (100%)
When NOT to Use:
• Multiple data series (use column/bar instead)
• Many categories (becomes cluttered)
• Precise value comparison (column chart better)
• Changes over time (line chart better)



Creating Pie Charts

Pie Chart Subtypes:
1. Pie:
• Standard circular pie chart
• Shows all slices in single circle
2. Exploded Pie:
• Slices separated from center
• Emphasizes individual segments
• Can explode all slices or specific slices
3. Pie of Pie:
• Main pie with secondary pie showing detail of one slice
• Best for: One slice contains multiple small components
4. Bar of Pie:
• Main pie with secondary bar chart showing detail
• Similar to Pie of Pie but uses bar chart



Creating Pie Charts

5. Doughnut:
• Pie chart with hollow center
• Can show multiple series (concentric rings)
• Center space available for labels or totals
Creating Pie Chart:
Organize data with categories in first column, values in 
second column
Select data range including headers (single series only)
Insert → Pie Chart → Choose subtype
Chart shows slices proportional to values
Example Data - Power Distribution:
Total: 30W
Result: Pie chart showing each component's percentage 
of total power



Creating Pie Charts

Formatting Pie Charts:
Slice Colors:
• Each slice gets unique color automatically
• Format individual slice: Click slice twice → Format Data Point
• Change fill color, add border, apply effects
Exploding Slices:
• Click slice twice to select individual slice
• Drag away from center to explode
• Or Format Data Point → Point Explosion slider (0-100%)
• Use to emphasize important segment
Data Labels:
• Essential for pie charts (show percentages or values)
• Chart Elements (+) → Data Labels → Outside End
• Format Data Labels → Label Options:



Creating Pie Charts

Percentage: Most common for pie charts
Value: Actual numbers
Category Name: Slice labels
Leader Lines: Connect labels to slices
Label Position:
• Center: Inside slice
• Inside End: Near edge inside slice
• Outside End: Outside slice with leader line
• Best Fit: Excel chooses automatically
Rotation:
• Format Chart Area → Series Options → Angle of first slice
• Rotate pie to position important slice at top (12 o'clock)
• Default: First slice starts at 12 o'clock



Creating Pie Charts

Engineering Application - Budget Breakdown:
Project budget pie chart showing percentage allocation:
• Components: 40%
• Labor: 30%
• Testing: 15%
• Documentation: 10%
• Contingency: 5%
Best Practices:
• Sort slices by size (largest to smallest) for clarity
• Use contrasting colors for adjacent slices
• Limit to 5-7 slices maximum
• Combine small slices into "Other" category if needed
• Always include data labels with percentages



Creating Scatter (XY) Charts

Scatter (XY) Charts:
Show relationship between two continuous variables. Both axes are value axes (not 
category).
When to Use:
• Correlation analysis between two variables
• Scientific and engineering data with independent and dependent variables
• Experimental measurements (input vs. output)
• Identifying patterns, trends, or outliers
• Calibration curves
• Characteristic curves (I-V, frequency response)
Key Difference from Line Charts:
• Line Chart: X-axis is category axis (evenly spaced labels)
• Scatter Chart: X-axis is value axis (scaled numerically)
• Result: Scatter charts accurately represent X-Y relationships



Creating Scatter (XY) Charts

Scatter Chart Subtypes:
1. Scatter with Only Markers:
• Points only, no connecting lines
• Best for: Showing correlation, identifying patterns
• Use when: No inherent order or connection between points
2. Scatter with Smooth Lines and Markers:
• Points connected with smooth curved lines
• Best for: Showing trend with actual data points visible
3. Scatter with Smooth Lines:
• Smooth curved lines only, no markers
• Best for: Emphasizing overall trend
4. Scatter with Straight Lines and Markers:
• Points connected with straight line segments
• Best for: Showing progression with data points



Creating Scatter (XY) Charts

5. Scatter with Straight Lines:
• Straight line segments only, no markers
• Best for: Connecting sequential measurements
Creating Scatter Chart:
Organize data with X-values (independent variable) in first 
column
Y-values (dependent variable) in second column
Select data range including headers
Insert → Scatter Chart → Choose subtype
X-values appear on horizontal axis, Y-values on vertical axis
Important: First column = X-axis, Second column = Y-axis
Example Data - Diode I-V Characteristic:
Result: Scatter chart showing exponential I-V relationship



Creating Scatter (XY) Charts

Adding Trendlines:
Trendlines show overall pattern in data and can display equation and R² value.
Steps:
Select data series in chart
Chart Elements (+) → Trendline → More Options
Or right-click series → Add Trendline
Format Trendline pane opens
Trendline Types:
• Linear: Straight line (y = mx + b)
Best for: Linear relationships
• Exponential: Exponential curve (y = ae^bx)
Best for: Exponential growth/decay
• Logarithmic: Logarithmic curve (y = a ln(x) + b)
Best for: Diminishing returns



Creating Scatter (XY) Charts

• Polynomial: Curved line (y = ax² + bx + c, or higher order)
Best for: Data with peaks and valleys
Order: 2-6 (higher = more curves)
• Power: Power curve (y = ax^b)
Best for: Proportional relationships
Trendline Options:
• Display Equation on chart: Shows mathematical formula
• Display R-squared value on chart: Shows goodness of fit (0-1, closer to 1 = better fit)
• Set Intercept: Force line through specific Y-intercept
• Forecast: Extend trendline forward or backward
Engineering Application - Sensor Calibration:
Plot sensor output vs. known input, add linear trendline with equation. Use equation to 
convert future sensor readings to actual values.



Creating Scatter (XY) Charts

Formatting Scatter Charts:
• Marker style, size, and color for data points
• Axis scales (linear or logarithmic)
• Gridlines for reading values
• Trendline style and color



Modifying Chart Data

Editing Data Source:
Change which data is included in chart.
Method 1 - Select Data:
1. Select chart
2. Chart Design tab → Data group → Select Data
3. Select Data Source dialog opens
4. Modify data range, add/remove series, edit labels
Select Data Source Dialog Components:
Chart Data Range:
• Shows current data range
• Click button to select new range in worksheet
• Includes all series and categories



Modifying Chart Data

Legend Entries (Series):
• Lists all data series in chart
• Add: Create new series (specify name and values)
• Edit: Modify series name or values
• Remove: Delete series from chart
• Up/Down Arrows: Change series order
Horizontal (Category) Axis Labels:
• Edit category labels
• Click Edit to select new range for labels
Switch Row/Column:
• Swap what's plotted as series vs. categories
• Useful when Excel interprets data incorrectly



Modifying Chart Data

Method 2 - Drag Data Range:
1. Select chart
2. Colored border appears around source data in worksheet
3. Drag corner handles to expand or contract data range
4. Chart updates automatically
Adding Data Series:
Method 1 - Select Data:
1. Chart Design → Select Data → Add
2. Edit Series dialog: 

Series name: Cell reference or type name
Series values: Select data range

3. Click OK



Modifying Chart Data
Method 2 - Copy and Paste:
1. Select new data column in worksheet (including header)
2. Copy (Ctrl + C)
3. Select chart
4. Paste (Ctrl + V)
5. New series added automatically
Removing Data Series:
1. Select series in chart (click bar, line, or legend entry)
2. Press Delete
3. Or Chart Design → Select Data → Select series → Remove
Editing Series Name:
1. Chart Design → Select Data
2. Select series → Edit
3. Edit Series dialog → Series name
4. Type new name or select cell reference
5. Click OK



Modifying Chart Data
Changing Category Labels:
1. Chart Design → Select Data
2. Horizontal Axis Labels → Edit
3. Select range containing new labels
4. Click OK
Switching Rows and Columns:
When Excel plots data incorrectly (series vs. categories swapped):
1. Chart Design tab → Data group → Switch Row/Column
2. Chart reorients data
3. Toggle back if needed
Hidden and Empty Cells:
1. Chart Design → Select Data → Hidden and Empty Cells
2. Choose how to handle: 

Gaps: Leave gaps in chart
Zero: Plot as zero value
Connect data points with line: Skip empty cells

3. Show data in hidden rows and columns (checkbox)



Chart Design and Layout Options

Quick Layouts:
Predefined combinations of chart elements for instant professional appearance.
Using Quick Layouts:
1. Select chart
2. Chart Design tab → Chart Layouts group → Quick Layout
3. Gallery shows layout thumbnails
4. Hover to preview
5. Click to apply
Layout Elements Included:
• Chart title position
• Axis titles presence and position
• Legend position
• Data labels
• Data table
• Gridlines



Chart Design and Layout Options

Advantages:
• Fast way to add multiple elements
• Professional combinations
• Starting point for further customization
Adding Chart Elements:
Chart Design tab → Add Chart Element button provides access to all elements.
Chart Element Options:
Axes:
• Show or hide primary/secondary axes
• Horizontal and vertical
Axis Titles:
• Primary Horizontal
• Primary Vertical
• Secondary (if applicable)



Chart Design and Layout Options
Chart Title:
• Above Chart
• Centered Overlay
• None
Data Labels:
• None, Center, Inside End, Outside End, Data Callout
• More Data Label Options (detailed formatting)
Data Table:
• With Legend Keys (shows series colors)
• No Legend Keys
• Displays source data below chart
Error Bars:
• Show uncertainty or variability in data
• Standard Error, Percentage, Standard Deviation
• Custom values
• Important for scientific/engineering data



Chart Design and Layout Options

Gridlines:
• Primary Major Horizontal/Vertical
• Primary Minor Horizontal/Vertical
• More Gridline Options
Legend:
• Right, Top, Bottom, Left
• None
• More Legend Options
Lines:
• Drop Lines, High-Low Lines, Up/Down Bars
• Series Lines (for stacked charts)
• Specific to certain chart types
Trendline:
• Linear, Exponential, Logarithmic, Polynomial, Power, Moving Average
• More Trendline Options



Chart Design and Layout Options

Up/Down Bars:
• For line charts with multiple series
• Shows difference between series
Chart Templates:
Save customized chart as template for reuse.
Creating Template:
1. Format chart with desired appearance
2. Right-click chart → Save as Template
3. Name template
4. Save in Templates folder



Chart Design and Layout Options

Using Template:
1. Select data
2. Insert → Recommended Charts → All Charts tab
3. Templates folder
4. Select saved template
5. Click OK
Benefits:
• Consistent appearance across multiple charts
• Save time on repetitive formatting
• Maintain organizational standards



Chart Best Practices for Engineering

Design Principles:
Clarity:
• Clear Title: Descriptive, includes key information
o Good: "Capacitor Voltage vs. Time During Charging (R=10kΩ, C=100µF)"
o Poor: "Chart 1“
 Axis Labels with Units: Always include units in axis titles

o Example: "Voltage (V)", "Time (s)", "Frequency (Hz)“
 Readable Fonts: Minimum 10-11 pt font size
 Sufficient Contrast: Dark text on light background or vice versa
 Uncluttered: Remove unnecessary elements (excessive gridlines, decorations)

Accuracy:
• Appropriate Scale: Start Y-axis at zero for bar/column charts (avoid misleading scaling)
• Linear vs. Logarithmic: Use log scale for data spanning multiple orders of magnitude
• Honest Representation: Don't manipulate scales to exaggerate differences
• Error Bars: Include when showing experimental data with uncertainty



Chart Best Practices for Engineering

• Significant Figures: Match precision to measurement accuracy
Appropriate Chart Type:
• Comparison: Column or bar chart
• Trend over time: Line chart
• Correlation: Scatter chart with trendline
• Proportion: Pie chart (limited categories)
• Distribution: Histogram or box plot
Professional Appearance:
• Consistent Formatting: Same style across all charts in document
• Color Scheme: Professional, coordinated colors (avoid garish combinations)
• Legend: Clear, positioned appropriately
• Gridlines: Subtle (light gray), only if needed for reading values
• White Space: Adequate margins and spacing



Chart Best Practices for Engineering

Engineering-Specific Guidelines:
Data Integrity:
• Plot actual measured data points (use markers)
• Distinguish between measured data and fitted curves
• Document data source and conditions
• Include sample size or number of measurements
Technical Standards:
• Follow IEEE, ISO, or institutional style guidelines
• Use standard symbols and notation
• Include figure numbers and captions
• Reference charts in text ("as shown in Figure 3")



Chart Best Practices for Engineering

Axis Considerations:
• Independent Variable: Typically X-axis (horizontal)
• Dependent Variable: Typically Y-axis (vertical)
• Multiple Scales: Use secondary axis when comparing different units
• Logarithmic Scales: Common for frequency response, power, gain
Color for Meaning:
• Red: Error, warning, failure
• Green: Pass, success, normal
• Blue: Neutral, information
• Consistent color coding across related charts
Accessibility:
• Readable in black-and-white (test print preview)
• Colorblind-friendly palettes
• Patterns or markers in addition to colors
• High contrast for projection



Chart Best Practices for Engineering

Common Mistakes to Avoid:
Visual Errors:
• 3D effects (distort perception, avoid unless necessary)
• Excessive decoration (chart junk)
• Too many data series (limit to 3-5 for clarity)
• Pie charts with too many slices (>7)
• Missing or unclear labels
Data Errors:
• Truncated Y-axis (misleading comparisons)
• Inconsistent scales across related charts
• Mixing chart types inappropriately
• Plotting categorical data on scatter chart



Chart Best Practices for Engineering

Technical Errors:
• Missing units in axis labels
• Incorrect axis assignment (independent vs. dependent)
• No error bars on experimental data
• Unlabeled trendlines or curves



Practical Engineering Examples

Example 1 - RC Circuit Time Constant 
Measurement
Objective: Visualize capacitor charging in RC circuit
Chart Type: Scatter chart with smooth lines and 
markers
Key Elements:
• Title: "Capacitor Voltage vs. Time (R=10kΩ, 
C=100µF, τ=1s)"
• X-axis: "Time (s)"
• Y-axis: "Voltage (V)"
• Exponential trendline with equation
• Markers showing actual measurements
• Horizontal reference line at 63.2% (one time 
constant)

Data: 

Analysis: Chart clearly shows 
exponential charging characteristic, 
time constant visible at 63.2% of final 
voltage.



Practical Engineering Examples

Example 2 - Component Performance Comparison
Objective: Compare three voltage regulators under 
different load conditions
Chart Type: Line chart with markers
Key Elements:
• Title: "Voltage Regulator Performance Under 
Load"
• X-axis: "Load Current (mA)"
• Y-axis: "Output Voltage (V)"
• Three series (Reg A, B, C) with different colors 
and markers
• Legend identifying each regulator
• Horizontal reference line at 5.0V (target voltage)
• Gridlines for reading values

Data: 

Analysis: Chart shows Regulator B 
has best load regulation, Regulator C 
shows significant voltage drop under 
load.



Practical Engineering Examples

Example 3 - Power Distribution Analysis
Objective: Show how total power is distributed 
among circuit components
Total: 30.0 W
Chart Type: Pie chart
Key Elements:
• Title: "Power Distribution in Embedded System"
• Data labels showing percentages and component 
names
• Processor slice exploded (largest consumer)
• Professional color scheme
• Total power noted in subtitle or caption

Data: 

Analysis: Processor consumes 50% 
of total power, primary target for 
power optimization.



Practical Engineering Examples

Example 4 - Frequency Response Measurement
Objective: Plot amplifier gain vs. frequency
Key Elements:
• Title: "Amplifier Frequency Response"
• X-axis: "Frequency (Hz)" - Logarithmic scale
• Y-axis: "Gain (dB)"
• Smooth line connecting measurements
• Markers at measurement points
• Horizontal reference line at -3dB point (cutoff 
frequency)

Data: 

Analysis: Logarithmic X-axis 
essential for frequency data 
spanning multiple decades. Chart 
shows flat response in passband, 
rolloff at high frequencies.



Practical Engineering Examples

Example 5 - Measurement Statistics
Objective: Compare measurement precision across 
three test methods
Chart Type: Column chart with error bars
Key Elements:
• Title: "Measurement Method Comparison (n=20 
each)"
• X-axis: "Test Method"
• Y-axis: "Measured Voltage (V)"
• Columns showing mean values
• Error bars showing ±1 standard deviation
• Horizontal reference line at 5.0V (true value)
• Target tolerance band (shaded region 4.95-
5.05V)

Data: 

Analysis: Method C shows best 
precision (smallest error bars) and 
accuracy (closest to true value).



Practical Engineering Examples

Key Takeaways:
• Choose chart type based on data and message
• Always include descriptive titles and axis labels with units
• Use appropriate scales (linear vs. logarithmic)
• Add trendlines for correlation analysis
• Include error bars for experimental data
• Maintain professional, consistent formatting
• Test readability in black-and-white
• Reference charts in text with figure numbers
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